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WebCRMA Training 
 

I. Introduction 
A. Web Presence Templates 

• The Templates utilize best-practice design standards to ensure a consistent 
look and feel throughout the NIU website.   

• They utilize Dreamweaver template structure, which is supported by 
WebCRMA, so that certain sections of the pages can be easily edited. 

B. About WebCRMA 
• WebCRMA is the free NIU webserver environment designed and maintained 

by ITS for hosting websites.  WebCRMA also provides tools for maintaining 
and publishing web content.  WebCRMA can be accessed via a web 
browser, so there are no software licensing requirements required. 

• The Web Presence Team is in the process of purchasing a new, more 
robust Content Management System (CMS), which will replace WebCRMA. 

 
II. Getting into WebCRMA 

A. WebCRMA access via the following url:  http://www.niu.edu/webcrma 
B. Requirements 

Since WebCRMA is a web based application, it requires specific requirements to 
operate properly, and otherwise problems with functionality may arise. 

1. Internet Explorer 5.5+ 
2. Security Certificate should be installed 

http://its.niu.edu/its/internet/certificate/certificate.shtml  
3. Sun Java installed http://www.java.com  
4. NDS account & password (without context) with proper rights in WebCRMA 

• You need a valid University NDS account and password (Novell login).   
• Permission to access directories in WebCRMA requires completion of 

the Computer Access Request Form, found at 
http://its.niu.edu/its/apps/car  

5. Workstation within the NIU Domain 
• To access WebCRMA from off-campus locations you will need to use 

the Virtual Private Network (VPN in order to be considered within the 
NIU domain.  Information regarding the NIU VPN can be found at 
http://securenet.niu.edu/vpnpptpmain.shtml  

6. Disable Pop-Up blockers 
• WebCRMA will spawn new browser windows as dialogue boxes to 

perform functions.  Pop-Up blockers will prevent this from happening.   
 

III. WebCRMA Three-Tier system 
A. Development 

1. The Development (Dev) platform is a testing platform for users to create or 
modify pages “in progress”.  Web documents may be created or modified at 
this tier using “Author Tools.” 
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2. Files on the Dev tier can be accessed from workstations within the NIU 
domain through the URL “http://dev.niu.edu/[path and file]” . 

3. This tier is associated with “User/Author” permissions. 
B. Evaluation (Quality Assurance) 

1. The Evaluation (QA) platform is used by some departments for editorial 
review, evaluation, and quality control.  In this tier, items that “Authors” have 
promoted for review are evaluated by “Reviewers” before moved into 
production.  Content on QA is not modified directly.  It is promoted by 
Authors from Dev to QA and either promoted from QA to Prod or rejected 
and removed from the QA platform by Reviewers. 

2. Files on the QA tier can be accessed through the URL 
“http://qa.niu.edu/[path and file]” . 

3. This tier is associated with “Reviewer/Approver” permissions.   
C. Production (Live) 

1. The Production (Prod) platform is live information available on the Internet.  
Content on Prod is not directly modifiable.  Any changes (new files, 
deletions of old files, or modifications of existing files) must go through the 
Dev and QA tiers before being reflected on Prod. 

2. Files on the Prod tier can be accessed through the URL 
“http://www.niu.edu/[path and file]”  

 
IV. Working in the WebCRMA environment 

A. Adding files to WebCRMA 
1. Use Author Tools and creates a new pages or modify content. 
2. Using the Upload Author Tool 

• The Author Tools environment has an upload function built-in.  This can 
be used to take files that are available on your local disk or network 
disks and upload them into the WebCRMA Dev tier.   

• The Upload tool works best in small doses (fewer than 5 files at a time)   
• Files must be checked out to be overwritten by uploaded files 

3. WebDAV Access -- (Network Place access to WebCRMA directories)  
• Helpful if moving lots of new files into the WebCRMA environment.  
• To set-up WebDAV Access, go to the WebCRMA site and click on 

“WebCRMA help”, from the top grey bar select “WebDAV Access” and 
follow the directions on the page. 

B. Check In / Check Out 
• WebCRMA is designed to protect files from redundant changes in a shared 

environment, by using “Check In / Check Out” process on the Dev tier. 
• For any existing file to be modified (edited, overwritten, or deleted), the file 

must first be “Checked Out” to the user wishing to make the changes.  While 
the file is checked out by one user, it is unavailable for modification by other 
users until it is checked back in.  This prevents two (or more) users from 
trying to make changes to the same file at the same time. 

• Users should be sure to check their files back in after making changes.  
Files can be checked in only by the user who has them checked out, or by 
ITS Campus Web Services. 
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C. Path and File 
1. WebCRMA will incorporate path locations to files if inserted from the editor 

window.  If a path is used in the creation of a document outside of 
WebCRMA, then the user will need to ensure that the path to the target is 
maintained. 

2. These steps will assist to ensure that path and file locations remain intact: 
• Avoid spaces in file and directory naming:  Spaces in names 

increase the chances of links not operating correctly. 
• Be aware of case in file naming:  The WebCRMA server is case 

insensitive.  Therefore, case is irrelevant.  Lower case is the standard 
for internet file publishing. 

• Use relative paths (path is relative to location of current document) 
• If you are working on files on your local drive (in the case for users that 

have needs beyond the Author Tools editor), make an exact copy of the 
folder structure used in WebCRMA in your local site folder. 

• The current path is visible for any index screen or editor window.  The 
path and file can also be determined from the URL:  
http://www.niu.edu/<PATH>/<FILE> 

D. Templates 
1. The Web Presence Template design is structured to work in WebCRMA.  
2. They contain a basic design for the page and keep common elements fixed.   
3. They contain specific and predefined editable areas for variable content. 

E. HTML vs. Graphical view 
1. Graphical Mode: Kind of WYSIWYG  

• Edit and format similar to Word 
• Need to view the file in a browser to see how it will really look 

2. HTML mode: Straight HTML code editing 
• May want to use for fine-tuning, or to fix images and links 

 
V. Sample Pages 

A. Creating new pages 
1. From a template: (File > New File from Template) 

• Type in file name. must end with .shtml as file type 
• Choose a template: For each left-navigation item that expands in your 

site, there are 10 template options (5 w/ Breadcrumbs and 5 w/o) 
(See Template Configurations handout – or Web Presence Project site) 

2. Editing the file 
• Check out and Edit file  
• Template tabs and content 

(1) All templates have sections called “doctitle” and “metatags.”  
(2) Include a “Breadcrumbs” tab, unless NoBreadcrumbs is in title 
(3) A variety of content areas depending on template selected 
(4) Use directions sheet, to change templates on page with content 
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B. Adding and editing page content 
1. Copying in external content 

• The cleanest way to copy content is using Dreamweaver or notepad 
• If copying from Word, copy content into notepad first and then pates 

and format in WebCRMA 
2. Formatting 

• Nearly all font styles are defined in a site-wide style sheet (CSS file) 
Pre-formatted place-holder text appears in each content tab 

• Use Heading & paragraph tags (in “formatting” drop-down menu) to 
format text size based on the CSS styles  

• Use Bold, Italic and list to format attributes of text 
• DO NOT USE: font color, font size, underline, alignment 

3. Adding Links 
• Highlight text you wish to link 
• Click on “insert” menu, and select “link” 
• If page you want to link to is part of your site, click the select link under 

internal and browse to desired file 
• If page you want to link to is on another site, enter the full URL for the 

site/page in the External link box. 
• If linking to a document other than a web page (PDF, DOC) or to an 

external webpage, set the target to “new window” 
4. Adding images 

• Adding a bowed banner image (only to no_breadcrumbs pages) 
(1) Select “Top Content” tab.  
(2) Place cursor in front of “Top Content section text”, hit “enter” 
(3) Go to insert > image, and navigate to banner image 
(4) Add ALT text describing image 
(5) Go to HTML view to remove <H2> tags 

• Adding feature images or images within content area 
(1) Place cursor where you want image to go 
(2) Go to insert > image, and navigate to desired image 
(3) Add ALT text describing image 
(4) Use class tags in HTML image code to modify placement relative 

to text (“class=image_left”  or “class=image_right”) Sample code: 
<IMG class=image left alt="Formula Car" 
src="/WebCRMATraining/Images/formula1_feature.jpg" border=0> 

• Pre-formatted images are in WebCRMA in  /NIUdefault/stockimages/ 
5. Save your file periodically, so you don’t loose anything. 
6. Deleting and restoring files 

• If you accidentally delete a file you can restore it with: 
Tools > Recycle Bin 

• If you want to restore a previous version of a page, select the page and 
then go to: Tools > Version History 
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C. “Promoting” and “Reviewing” files from Dev to QA to Production 
1. All files you plan to promote and approve must be checked-in… 
2. To have someone with access to your site review the files before going live: 

• Mark all files and select “tools” > “promote”.  
• Click the promote button. 

3. For files to go straight to the production server (live),   
• Mark all files and select “tools” > “promote”.  
• Click the “promote and approve” button.  

Only people with Author and Reviewer rights can approve. 
• If you have a large site, promote and approve the “templates” and 

“images” folders first…then all other files. Approve index.shtml file last. 
 

VI. WebCRMA and Template Odds & Ends 
A. Web Accessibility Standards 

The Web Presence templates have been designed with State web accessibility 
requirements in mind. The templates address many primary concerns, but you 
should be aware of page specific elements that impact accessibility issues for 
users with disabilities (i.e Alt tags, Heading tags, limited table use). 
http://www.niu.edu/webpresence/wptemplates/accessibility.shtml   

B. Changing templates on existing pages 
See enclosed handout printed from the Web Presence Project site: 
http://www.niu.edu/webpresence/config/change_templates.shtml  

C. Site Statistics 
Statistics are automatically generated for your site and can be accessed from the 
initial WebCRMA page. 

D. Updates and Outages:   
WebCRMA goes through weekly maintenance on Sundays and is down until 7 
p.m.  Availability of the system on Sundays may be limited.  Also, additional 
updates may be posted on the WebCRMA login page. 

E. Browser Navigation vs. WebCRMA Navigation:   
Wherever possible, avoid using commands for the browser for navigation (Back, 
Refresh, etc.).  Instead, use the commands within the WebCRMA environment.  
For example, if you are in Author Tools and editing a page, click on the button 
“Back to Index” rather than clicking “Back” or hitting the “Backspace” key. 

 
VII. More Information 

A. Web Presence Project Resources 
1. Web site http://www.niu.edu/webpresence  
2. WebTeam email: webteam@niu.edu 

B. WebCRMA Resources 
1. WebCRMA Help   
2. WebCRMA Tutorials  
3. WebCRMA Listserv:  http://www.its.niu.edu/webcrma/listserv.shtml 


